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Introduction
The Pixsys PL280 PLC range features a compact and flexible structure.
The PL280 CPU, in addition to managing a series of integrated I/Os, is configured as a control unit and 
connectivity node, complete with RS485 serial (Modbus RTU), Ethernet (Modbus TCP/IP), CANopen 
and internal real-time bus on DIN bar. For programming the logic, the LogicLab development 
environment is available for download at www.pixsys.net.

1	 Safety guidelines
Read carefully the safety guidelines and programming instructions contained in this manual before 
connecting/using the device.
Disconnect power supply before proceeding to hardware settings or electrical wirings to avoid risk of 
electric shock, fire, malfunction.
Do not install/operate the device in environments with flammable/explosive gases. 
This device has been designed and conceived for industrial environments and applications that rely 
on proper safety conditions in accordance with national and international regulations on labour 
and personal safety. Any application that might lead to serious physical dama ge/ life risk or involve 
medical life support devices should be avoided.
Device is not conceived for applications related to nuclear power plants, weapon systems, flight 
control, mass transportation systems.
Only qualified personnel should be allowed to use device and/or service it and only in accordance to 
technical data listed in this manual.
Do not dismantle/modify/repair any internal component.
Device must be installed and can operate only within the allowed environmental conditions.
Overheating may lead to risk of fire and can shorten the lifecycle of electronic components.

1.1	 Organization of safety notice
Safety notices in this manual are organized as follows:

Safety notice Description

Danger! Disregarding these safety guidelines and notices can be life-threa-
tening.

Warning! Disregarding these safety guidelines and notices can result in severe 
injury or substantial damage to property.

Information! This information is important for preventing errors.

1.2	 Safety Precautions

Danger!
CAUTION - Risk of Fire and Electric Shock
This product is UL listed as open type process Control Equipment. It must be mounted in 
an enclosure that does not allow fire to escape externally.

Danger!

If the output relays are used past their life expectancy, contact fusing or burning may 
occasionally occur.
Always consider the application conditions and use the output relays within their 
rated load and electrical life expectancy. The life expectancy of output relays varies 
considerably with the output load and switching conditions.

Warning!
Devices shall be supplied with limited energy according to UL 61010-1 3rd Ed, section 9.4 
or LPS in conformance with UL 60950-1 or SELV in conformance with UL 60950-1 or Class 
2 in compliance with UL 1310 or UL 1585..

Warning! Loose screws may occasionally result in fire.
For screw terminals, tighten screws to tightening torque is 0.22 Nm

Warning!

A malfunction in the Digital Controller may occasionally make control operations 
impossible or prevent alarm outputs, resulting in property damage. To maintain safety 
in the event of malfunction of the Digital Controller, take appropriate safety measures, 
such as installing a monitoring device on a separate line.

Table of contents
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1.3	 Precautions for safe use
Be sure to observe the following precautions to prevent operation failure, malfunction, or adverse 
affects on the performance and functions of the product. Not doing so may occasionally result in 
unexpected events. Do not handle the Digital Controller in ways that exceed the ratings.
• The product is designed for indoor use only. Do not use or store the product outdoors or in any of 
the following places.
- Places directly subject to heat radiated from heating equipment.
- Places subject to splashing liquid or oil atmosphere.
- Places subject to direct sunlight.
- Places subject to dust or corrosive gas (in particular, sulfide gas and ammonia gas).
- Places subject to intense temperature change.
- Places subject to icing and condensation.
- Places subject to vibration and large shocks.
• Installing two or more controllers in close proximity might lead to increased internal temperature 
and this might shorten the life cycle of electronic components. It is strongly recommended to install 
cooling fans or other air-conditioning devices inside the control cabinet.
• Always check the terminal names and polarity and be sure to wire properly. Do not wire the terminals 
that are not used.
• To avoid inductive noise, keep the controller wiring away from power cables that carry high 
voltages or large currents. Also, do not wire power lines together with or parallel to Digital Controller 
wiring. Using shielded cables and using separate conduits or ducts is recommended. Attach a surge 
suppressor or noise filter to peripheral devices that generate noise (in particular motors, transformers, 
solenoids, magnetic coils or other equipment that have an inductance component).
When a noise filter is used at the power supply, first check the voltage or current, and attach the 
noise filter as close as possible to the Digital Controller. Allow as much space as possible between 
the Digital Controller and devices that generate powerful high frequencies (high-frequency welders, 
high-frequency sewing machines, etc.) or surge.
• A switch or circuit breaker must be provided close to device. The switch or circuit breaker must be 
within easy reach of the operator, and must be marked as a disconnecting means for the controller.
• Wipe off any dirt from the Digital Controller with a soft dry cloth. Never use thinners, benzine, alcohol, 
or any cleaners that contain these or other organic solvents. Deformation or discoloration may occur.
• The number of non-volatile memory write operations is limited. Therefore, use EEprom write mode 
when frequently overwriting data, e.g.: through communications.

1.4	 Environmental policy / WEEE
Do not dispose electric tools together with household waste material.
According to European Directive 2012/19/EU on waste electrical and electronic equipment and its 
implementation in accordance with national law, electric tools that have reached the end of their life 
must be collected separately and returned to an environmentally compatible recycling facility.

2	 Model identification
PL280-1AD PLC DIN RAIL 1 ETHERNET; 1 RS485; 1 CANopen; 1 PLE DIN BUS

4 Analog inputs; 2 Analog Outputs; 24 Digital I/Os; 2 Pulse train Outputs

3	 Technical data
3.1	 General characteristics
Power supply 12..24 VDC ± 10% 
Consumption 5W
Operating conditions Temperature: 0-45°C; humidity 35..95 RH% without condensation
Container 162 x 90 x 64 mm - 9 modules DIN43880

Materials Container: Noryl V0;
Front panel: siliconic rubber V0 self-extinguishing
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Protection IP20 (container and terminals)
Weight Approximately 130 g

3.2	 Hardware characteristics
CPU ARM Cortex H7 @ 480MHz
Memory Flash 2 Mb / RAM 1 Mb

Digital inputs 16 PNP inputs 12-24Vdc
(8 superimposed to the digital outputs)

V
IL

 = 4,4V
V

IH
 = 8,2V 

Encoder/counter 
inputs

4 encoder/counter superimposed to the
digital inputs PNP

Resolution 32 bit
Maximum frequency 100KHz

Analogue inputs

4 inputs configurable via software.
Thermocouples: type K, S, R, J, T, E, N, B; 
with automatic cold junction compensation 
from 0..50°C.
Thermoresistance: PT100, PT500,
PT1000, Ni100, PTC1K, NTC10K (β 3435K)
Input VI: 0-10V, 0-20 o 4-20mA,
0-60mV, 0-1V, 0-5V
Pot. input: 1..150 kΩ

Tolerance: (@ 25 °C)
± 0.2% ± 1 digit (on F.s.)
Resolution: 16 bit

Digital outputs 16 static outputs 12-24Vdc
(8 superimposed to the digital inputs)

Max 700mA for each output
Max 2A total for each 8-outputs 
group (Q.0.0-Q.0.7 e Q.1.0-Q.1.7)

Analogue outputs 2 outputs configurable via software. 
0-10V or 4-20mA Resolution: 16 bit

PTO outputs (Pulse 
Train Output)

2 outputs configurable via software:
On/Off, PTO or PWM 12.24Vdc

Max 20mA for each output
Max frequency 200KHz

COM1/RS485 port RS485 with Modbus RTU master/slave 
protocol Up to 115200 baud

CAN1 CANopen port CAN with CANopen master protocol Up to 1Mbit

Bus PLCEXP Realtime communication with expansion 
modules PLE500-xx series

Ethernet port With Modbus TCP master/slave protocol

3.3	 Software characteristics
Minimum cycle time 1mS
Public objects - 
Parameters (non-volatile) 3800 words 150 year data retention

Public objects - 
Status variables (volatile) 4096 words

Retain Variables 2KB 60 days data retention with rechargeable battery capacitor
Retain Datablock 2KB 60 days data retention with rechargeable battery capacitor
PLC code size 476KB
PLC data size 128KB

Modbus TCP Master Max. slave: 16
Max. word reading: 2048 - Max. word writing: 2048

Modbus RTU Master Max. slave: 120
Max. word reading: 1024 - Max. word writing: 1024
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4	 Dimension and installation

4.1	 Mounting sequence of the PL280 and of the PLE500 
expansion modules

The PL280 with the relevant I/O modules requires mounting and connection via the specific bus 
lodged in the hollow of the DIN rail. The I/O modules (series PLE500-xAD) will be automatically 
numbered at each power-on, assigning the number 1 to the first I/O module connected to the right 
of the PL280, the number 2 to the following one and so on, always moving towards the right side.
The position of the various modules shall thus reflect the sequence set in the LogicLab project in the 
definition of the PLCEXP network. For the numbering procedure to work correctly, removing devices 
from the network is not allowed by releasing them from their own bus and leaving some empty 
modules (slot bus) between one module and the other. All the connection/disconnection operations 
must be carried out with power off.

Clik!
Couple all the buses by pushing them towards the DIN 
rail, making sure that the male connection faces left 
and the female one faces right.

Couple the buses together by sliding them along the 
DIN rail.
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Insert the various modules in the slots of the buses 
starting from the PL280 and continuing to the right 
with the I/O modules.
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Proceed with mounting all the modules according to 
the requested order until the plc is completely formed.
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It is not possible to leave free slots in the bus between 
one module and another

5	 Electric connections
This instrument was designed and built in compliance with the Low Voltage Directives 2006/95/ CE, 
2014/35/EU (LVD) and Electromagnetic compatibility 2004/108/EC and 2014/30/EU (EMC). 
For installation in industrial environments it is a good rule to follow the precautions below: 
•	 Distinguish the power supply line from the power lines. 
•	 Avoid the proximity with contactor units, electromagnetic contactors, high power motors and 

use filters in any event. 
•	 Avoid the proximity with power units, particularly if with phase control. 
•	 The use of network filters is recommended on the power supply of the machine in which the 

instrument will be installed, particular in case of 230 VAC power supply. The instrument is devised 
to be assembled with other machines. Therefore, the EC marking of the instrument does not 
exempt the manufacturer of the system from the safety and conformity obligations imposed for 
the machine as a whole. 

•	 Wiring of pins use crimped tube terminals or flexible/rigid copper wire with diameter 0.25 to 1.5 
mm2 (min. AWG28, max. AWG16, operating temperature: min. 70°C). Cable stripping lenght 7 to 
8 mm.

5.1	 Wiring diagram
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PL280-1AD

5.1.a	 Power supply

1
–

SUPPLY
12..24 VDC

2

+

3
12...24VDC
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5.1.b	 Analog outputs AO1, AO2

AO.2
6

7

+

–

AO V
mA

Shield / Schermo

AO.1
4

5

Configurable:
0-10 V with 30000 points ±0.3% (on F.S.) @25 °C;
load >= 1 KΩ
4-20 mA with 25000 points ±0.3% (on F.S.) @25 °C;
load <= 500Ω

5.1.c	 Pulse Train Outputs PTO1 and PTO2

PTO.2
9

2

+

–

PTO.1
8

2

Configurable in three operating modes:
On/Off -Activation in on/off mode without preset logic.
PTO - Axis positioning management for stepper motors (with 
acceleration and deceleration ramp generation)
PWM - PWM output with variable frequency and duty-cycle 
(Frequency 1÷200000Hz, duty-cycle 0,00 ÷ 100,00%)

5.1.d	 Analog inputs for thermocouples

AI1
+

–

AI TC
11

10

AI2

14

13

AI3

17

16

AI4

20

19

Thermocouples K, S, R, J, T, E, N, B
Respect the polarity
For any extensions, use compensated cable and terminals suitable for 
the thermocouple used

5.1.e	 Analog inputs for thermoresistances PT100, NI100

AI1 AI2 AI3 AI4

AI

Rosso
Red

Bianco
White

Rosso
Red

PT
/N

I1
00

11

10

12

14

13

15

17

16

18

20

19

21

Use cables of the same cross-section for the three-wire connection
For two-wire connection short the terminals 11 and 12 (AI1), 14 and 15 
(AI2), 17 and 18 (AI3), 20 and 21 (AI4). 

RED
ROSSO

RED
ROSSO

WHITE
BIANCO 10

11

12

5.1.f	 Analog inputs for thermoresistances NTC, PTC

AI1 AI2

13

15

AI3

16

18

AI4

19

21
AI PT

C/
NT

C

10

12

Termoresistances type NTC-10K, PTC-1K, PT500 and PT1000
Linear potentiometers

5.1.g	 Analogue inputs for normalised signals

AI1 AI2 AI3 AI4
+

–

AI V
mA

11

10

14

13

17

16

20

19

Voltage signals 0..10V, 0..1V, 0..5V, 0..60mV
Current signals 0..20 mA, 4..20mA

5.1.h	 PNP digital outputs 24Vdc

22 23 28.. 29
Q.0.0VDC- Q.0.1 Q.0.6 Q.0.7 22: Output Q0.0

23: Output Q0.1
24: Output Q0.2
25: Output Q0.3

26: Output Q0.4
27: Output Q0.5
28: Output Q0.6
29: Output Q0.7
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5.1.i	 Positive power supply for outputs Q0.0÷ Q0.7

30
+VDC

12..24 VDC
Power supply for outputs’ block

5.1.j	 PNP digital inputs 24Vdc

12..24 VDC I0.1 I0.2 I0.6 I0.7
36 37 42.. 43

36: Input I0.0
37: Input I0.1
38: Input I0.2
39: Input I0.3

40: Input I0.4
41: Input I0.5
42: Input I0.6
43: Input I0.7

5.1.k	 PNP digital inputs 24Vdc / Outputs 24Vdc

45 46 51.. 52

I/Q
1.

0

I/Q
1.

1

I/Q
1.

6

I/Q
1.

7

12..24 VDC

- VDC

45: Input/Output I/Q1.0
46: Input/Output I/Q1.1
47: Input/Output I/Q1.2
48: Input/Output I/Q1.3

49: Input/Output I/Q1.4
50: Input/Output I/Q1.5
51: Input/Output I/Q1.6
52: Input/Output I/Q1.7

5.1.l	 Positive power supply for outputs Q1.0÷ Q1.7

53
+VDC

12..24 VDC
Power supply for outputs’ block

5.1.m	 Push-Pull Encoder inputs
ENC2

38
ENC3

40
ENC4

42A

B

Z
+- SUPPLY

ENC1

36
39 41 4337
46 47 4845EN

CO
DE

R Use only push-pull encoders
Maximum frequency 100KHz

5.1.n	 Counter input

CNT2

38
CNT3

40
CNT4

42
+- SUPPLY

CNT1

36 PNP inputs
Maximum frequency 100KHz

5.1.o	 Serial COM1/RS485

CA-B+

313 32 33 31: (B+) RS485+
32: (A-) RS485-
33: (C) Reference 
Connect any cable shield to terminal 3

5.1.p	 Bus CAN1

CCANLCANH

353 34 33 CAN MASTER:
35: (H) CanH
34: (L) CanL
33: (C) Reference 
Connect any cable shield to terminal 3.
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5.1.q	 Ethernet

10/100 Mbit Ethernet port for programming from development 
software and network connectivity.

5.1.r	 PLE / DIN bus

Bus connector to be housed in the recess of the DIN rail to connect 
any I/O modules to the PL500. For mounting sequence, see section 
1.2.

5.1.s	 USB

USB 2.0 port for Backup / Restore of applications and mass storage 
functionality (memory must be formatted in FAT/FAT32).

5.1.t	 S1 button for system’s Backup / Restore (internal)
Backup:
The backup procedure allows the complete configuration of the device to be 
saved to a USB memory of both the code and the retintive memories. 
1 - Switch on the PLC 
2 - Insert a USB memory (external)
3 - Open the front cover and press S1 button for approximately 8 seconds 
(the green CONFIRM led lights up).
4 - Release the S1 button
5 - Wait for the completion of the backup procedure.
During the procedure, the red RUN LED flashes and the progress of the 
procedure is indicated by the LEDs lighting up in sequence from I.0.0 to 
I/Q.1.7. The yellow COM LED indicates the presence of the USB memory.
At the end of the procedure, the green RUN LED lights up steadily.
In case of errors during the procedure, the red RUN LED lights up steadily.
6 - Switch off the PLC, remove the USB memory and switch the device on 
again.

If the programme on the PLC is password-protected, a Password.txt file containing the programme 
protection password must be placed in the root of the USB memory, otherwise the backup 
procedure will not be performed. Once the backup is executed, the file can be removed from the 
memory.
At the end of the backup, a BackupLog.txt file containing the outcome of the procedure will be 
generated in the root of the USB memory.

Restore:
1 - Insert a USB memory containing the backup with the PLC switched off.
2 - Switch on the PLC while holding down the S1 button (the green CONFIRM 
LED lights up).
3 - Wait for the completion of the Restore procedure.
During the procedure the red RUN LED flashes and the progress of the 
procedure is indicated by the LEDs I.0.0 to I/Q.1.7 lighting up in sequence. 
The yellow COM LED indicates the presence of the USB memory.
At the end of the procedure, the green RUN LED lights up steadily.
In case of errors during the procedure, the red RUN LED lights up steady.
5 - Switch off the PLC, remove the USB memory and switch the device.
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5.2	 Meaning of the status indicators (LEDs)
 RUN Fixed on: indicates that PLC is in STOP status
 RUN Fixed on: indicates that PLC is normally running

 RUN Alternating flash every 0,5s indicates that the device discovery procedure is running
 COM It turns on of 100 ms for each communication frame sent through COM1/RS485 port
 AO1...2 Fixed on: indicates that corresponding analog output is active
 PTO1...2 Fixed on: indicates that corresponding pulse train output is active

 AI1...4
Fixed on: indicates that corresponding analog input is active and is correctly working.
Flashing: indicates that corresponding analog input is in an error status. This could be 
an incorrect probe, disconnected, shorted or out of range.

 I.0.0...7 Fixed on: indicates that corresponding digital input is active
 Q.0.0...7 Fixed on: indicates that corresponding digital output is active
 I/Q.0.0...7 Fixed on: indicates that corresponding digital input or output is active

6	 Suite LogicLab
The LogicLab Suite is Pixsys’ development environment for programming the PL280 PLC and the 
entire family of operator terminals and PanelPCs.
The suite can be downloaded from the download area of the pixsys.net website, subject to registration 
and does not require activation codes. It is compatible with all versions of Windows 32/64bit starting 
from Windows XP SP3 and is available in English and Italian. 
Once you have downloaded the setup file onto your computer, start the installation and follow the 
standard procedure. 
Once the programme is installed, it starts via the  “LogicLab” icon on the desktop or from the “Start” 
menu > “PixsysSuite” > “LogicLab”.

6.1	 Change language

To change the display language, open the options 
window from the ‘File’ > ‘Options’ menu, switch to the 
‘Language’ tab, select ‘ITA - Italian’ and press ‘Select’.
Then confirm with “OK” and finally close and reopen 
LogicLab for the changes to take effect.

6.2	 Creation - loading of a project

LogicLab start screen
•	 Once the application is launched, a series of 

options are presented to create or open a 
project, scan the network for connected devices 
recognised by the development environment, or 
select one of the devices.
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Scan network…
•	 By clicking on the Scan Network button, LogicLab 

performs a search for all programmable devices 
present on the network and fills in the “Scan 
result” table

•	 Depending on the type of device detected, 
certain operations are possible directly on the 
selected device via the buttons in the table.

•	 For the PL280, the button  can be used to 
initiate the discovery mode on the selected 
device, which consists of making the RUN LED 
flash alternately red/green for about 5 seconds, so 
as to be able to establish with certainty whether 
it is the right device if more than one of the same 
type has been detected during the scan.

•	 For the PL280, you can use the button  to 
open a screen where you can change the device’s 
network settings.

Opening an existing project:
•	 With LogicLab open, click on the “Open Project” 

button or select one of the last open projects 
from the proposed list.

•	 With LogicLab closed, enter the project folder 
and double-click on the file with the desired 
project name, which will have the icon and 
extension “.plcprj”.

Create a new project:
•	 Press the “New Project” button or, from the “Scan 

result” table, select the device you want to work 
on and press the button .

•	 In the window that appears, type a name for the 
project and identify the folder where the project 
files will be placed. Finally, select the device to be 
programmed.

Caution: by selecting the “respect uppercase/lowercase letters” flag, a variable containing an 
uppercase letter will be understood as different from another variable of the same name but with that 
lowercase letter. We therefore recommend leaving this selection disabled, to avoid confusion when 
writing programme code.

6.3	 Link to target
Listed below are the requirements for the correct connection between the target (device to be 
programmed) and the PC development environment (LogicLab).

Requirements to be checked on the target:
•	 device switched on and started up
•	 onfigured with a static IP address compatible with the network where it is located and the PC 

with which it is to connect. By default, the IP address of the PL280 is 192.168.0.99, so the PC where 
it is being developed must have the same network and class (in this case 192.168.0.XXX) but a 
different physical address (i.e. the last 3 digits of the IP address, with any number between 1 and 
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255, other than 99). If it is necessary to change the IP address of the PL280 from the default one, 
please refer to the instructions in the previous paragraph.

•	 network cable connection (direct or cross) directly to the PC or via a network switch

Requirements to be verified on the development PC:
•	 IP address compatible with the existing network where it is located and with the IP address 

configured in the target (see previous points)
•	 Antivirus/firewall allowing connection to devices in the network (these are usually already 

configured correctly)
•	 LogicLab configured to connect to the connected target that you want to programme: to do 

this, navigate to the “On Line” > “Set up communication” menu and in the window that appears, 
press the “Properties” button and then under “IP Address” enter the IP address of the target, leaving 
everything else unchanged. In the case of very slow networks or a network configuration with 
several switches, you can increase the “Timeout” value (in mS).

The image shows the default configuration

Confirm all windows by pressing “OK” and save via the icon  or via the menu “file” 
> “Save Project”.
At this point, to check that the configuration of LogicLab and the target is correct, you can 
connect by pressing the icon  or from the menu “On Line” > “Connect”. If the connection 
is successful, the status bar in the bottom right-hand corner will display “CONNECTED” and 
“NO CODE” to indicate that the target is connected and has no code in it, or “CODE DIFF” 
to indicate that the code being displayed does not correspond to the code in the target. 

6.4	 Compiling and downloading the code
Once you have entered the project code, you must compile it to check that there are no errors, by 
pressing the F7 key, via the icon  or from the menu “Project” > “Compile”.
If the compilation is successful, you can transfer the programme to the target by pressing the F5 key, 
via the icon  or from the menu “On Line” > “Transfer code”.
At this point, the status bar will display “CONNECTED” and “SOURCE OK” indicating that the programme 
running in the target corresponds to the one being displayed on the PC.

6.5	 The watch window
If the programme running in the target corresponds to the one being displayed on the 
PC, the status bar will display “CONNECTED” and “SOURCE OK” and you can then use the 
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“Watch” window to check, in real time, the status of the variables used in the project. To 
enable the “Watch” window, press CTRL+T or use the “View” menu > “Tool Window” > “Watch”.  
To add a variable to the “Watch” window, simply drag it inside or press the icon  and select it 
manually.

From now on, the “Watch” window will begin to 
display the value of the variable entered, in real time.

Using the appropriate buttons  it is also possible to save, load and add to an existing watch 
list.

If you wish to change the display format, simply select 
the variable and press the icon 
From the window that appears, select the desired 
format and confirm with “OK”.

7	 PL280’s local resources “Local IO Mapping“
The hardware resources available in the PL280 are available in the “Local IO Mapping” section of the 
programme, subdivided into categories in order to make them more usable and easier to use. The 
“Parametrization” section allows all the parameters governing the operation of the PL280 to be set. 
Parameter configuration is automatically handled during the initialisation phase of the PLC. Further 
parameter changes “on the fly” during program execution must be made by calling up the system 
function “sysApplyIOConfiguration(0);”

The “Local IO Mapping” management makes it possible 
to map all local resources available in the PL280 to 
variables that can be used by the programme.
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7.1	 Parametrization
1	 Sensor type AI1
2	 Sensor type AI2
3	 Sensor type AI3
4	 Sensor type AI4

Analogue input configuration / sensor selection
 0	 Disable (Default)
 1 	 Tc K	 -260 °C..1360 °C
 2	 Tc S	 -40 °C..1760 °C
 3	 Tc R	 -40 °C..1760 °C
 4 	 Tc J 	 -200 °C..1200 °C
 5 	 Tc T 	 -260 °C..400 °C
 6 	 Tc E 	 -260 °C..980 °C
 7 	 Tc N 	 -260 °C..1280 °C
 8 	 Tc B 	 100 °C..1820 °C
 9 	 PT100 	 -100 °C..600 °C
10 	 NI100 	 -60 °C..180 °C
11 	 NTC-10K 	 -40 °C..125 °C 
12 	 PTC-1K 	 -50 °C..150 °C
13 	 PT500 	 -100 °C..600 °C
14 	 PT1000  	 -100 °C..600 °C
15 	 0..1V
16 	 0..5V
17 	 0..10V
18 	 0..20mA
19 	 4..20mA
20 	 0..60mV
21 	 Potentiometer (set the value on param. 14..17)
22	 Counts PGA 64
23	 Counts PGA 128

5	 Degree
0	 °C 	 (Celsius) (Default)
1	 °F 	 (Fahrenheit)
2	 K 	 (Kelvin)

6	 Lower limit input AI1
7	 Lower limit input AI2
8	 Lower limit input AI3
9	 Lower limit input AI4

Lower limit of analog input only for normalised signals. Ex: with input 4..20 mA this parameter 
indicates value associated to 4 mA
-32768..+32767, Default: 0.

10	 Upper limit input AI1
11	 Upper limit input AI2
12	 Upper limit input AI3
13	 Upper limit input AI4

Upper limit of analog input only for normalised signals. Ex: with input 4..20 mA this parameter 
indicates value associated to 20 mA 
-32768..+32767, Default: 1000

14	 Potentiometer Value AI1
15	 Potentiometer Value AI2
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16	 Potentiometer Value AI3
17	 Potentiometer Value AI4

Set the value of the potentiometer connected to analogue input.
1..150 kohm, Default: 10kohm

18	 Linear Input over Limits AI1
19	 Linear Input over Limits AI2
20	 Linear Input over Limits AI3
21	 Linear Input over Limits AI4

For linear input, it allows the process to exceed the minimum and maximum numerical limits 
(Par. 6..9 e 10..13).
0 Off
1 On

22	 Offset Calibration AI1
23	 Offset Calibration AI2
24	 Offset Calibration AI3
25	 Offset Calibration AI4

Value added/subtracted to the process value (ex: normally used to correct environmental 
temperature).
-10000..+10000 [digit] (degrees.tenth for temperature sensors). Default 0.

26	 Gain Calibration AI1
27	 Gain Calibration AI2
28	 Gain Calibration AI3
29	 Gain Calibration AI4

Value multiplied to the process value to calibrate the working point. Ex: to correct the range from 
0..1000°C showing 0..1010°C, set the parameter to -1.0
-1000 (100.0%)...+1000 (+100.0%), Default: 0.0.

30	 Reserved
31	 Reserved
32	 Reserved
33	 Reserved

34	 Input Filter AI1
35	 Input Filter AI2
36	 Input Filter AI3
37	 Input Filter AI4

Analogue input reading filter: increases the stability of the analogue reading value. Indicates the 
number of samples to be averaged in the process calculation.
1...50. (Default: 10)

38	 Maximum difference for new sampling AI1
39	 Maximum difference for new sampling AI2
40	 Maximum difference for new sampling AI3
41	 Maximum difference for new sampling AI4

Defines the maximum absolute value of difference between the current process value and the 
new sampling to consider this value acceptable (and therefore inserted in the average managed 
by the parameter “34..37 Input filter”) or reject it.
1..32767 [tenth of °C or digit], Default: 10,0 °C

42	 Maximum duration of sampling discard AI1
43	 Maximum duration of sampling discard AI2
44	 Maximum duration of sampling discard AI3
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45	 Maximum duration of sampling discard AI4
Determines the maximum duration for which the analog input samples can be discarded if 
considered unacceptable (vedi parametri 70..73). After this time, any sampling value will be 
considered valid.
0..200 [tenth of second], Default: 1,0 s

46	 Conversion Frequency AI1, AI2
47	 Conversion Frequency AI3, AI4

Conversion frequency of the analogue digital converter. Lower frequencies slow down the 
sampling but increase the reading accuracy, while higher frequencies increase the sampling time 
at the expense of the reading accuracy of the analogue input.
0	 4 Hz
1	 6 Hz
2	 8 Hz
3	 10 Hz
4	 12 Hz
5	 17 Hz (Default)
6	 20 Hz

 7	 33 Hz
 8	 39 Hz
 9	 50 Hz
10	 62 Hz
11	 123 Hz
12	 242 Hz
13	 470 Hz

48	 Digital Input Filter
Defines the time for which the digital input must remain stable before being considered valid.
0..250 [base 1,0 ms], Default: 5 x 1,0 = 5 ms.

49	 Encoder/counter setup 1
50	 Encoder/counter setup 2
51	 Encoder/counter setup 3
52	 Encoder/counter setup 4

Determines the operating mode of the one-way encoder or counter input.
0	 Disable
1 	 Encoder x2 phase A-B
2 	 Encoder x4 phase A-B
3 	 Encoder x2 phase A-B-Z
4 	 Encoder x4 phase A-B-Z
5 	 Counter Up
6 	 Counter Down(not allowed for P052)

53	 Encoder/counter preset 1
55	 Encoder/counter preset 2
57	 Encoder/counter preset 3
59	 Encoder/counter preset 4

Determines the value that will be loaded into the count register of the encoder or counter when 
the load command occurs.
-2147483648..2147483647  [digit], Default: 0.

61	 Offline Time
Determines the time in ms taken by the plc to activate the “error” outputs in the event of a 
communication failure with the built-in I/O.
0 Off
1 to 60000 time in ms

62	 Q0.0÷I/Q1.7 output value in error
Determines the value of the pulse train output in the event of an error or fault.
The value must be between the minimum and maximum limits of the output.
-32768..+32767 [digit], Default: 0.
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63	 Output type AO1
64	 Output type AO2

Selects the analogue output operating mode.
0	 0-10 V (Default)
1	 4-20 mA

65	 Lower Limit Analog Output AO1
66	 Lower Limit Analog Output AO2

Lower limit continuous output range (value associated with 0 V or 4 mA).
-32768...+32767 [digit], Default: 0.

67	 Upper Limit Analog Output AO1
68	 Upper Limit Analog Output AO2

Upper limit continuous output range (value associated with 10V or 20mA).
-32768...+32767 [digit], Default: 1000.

69	 A01 output value in error
70	 A02 output value in error

Determines the value of the analogue output in the event of an error or fault.
The value must be between the minimum and maximum limits of the output.
-32768..+32767 [digit], Default: 0.

71	 Output type PTO1
72	 Output type PTO2

Selects the operating mode of the PTO output (Pulse Train Output).
0	 Out On/Off (Default)
1	 Out PTO
2	 Out PWM

73	 Pulses per motor revolution PTO1
74	 Pulses per motor revolution PTO2

Sets the number of pulses to be generated for the stepping motor to complete one full revolution.
1..32000 [pulses], Default: 200.

75	 Load movement per motor revolution PTO1
77	 Load movement per motor revolution PTO2

Determines the value of the physical axis displacement for each complete motor revolution. 
1..2147483647 [base 0,1 mm], Default: 2000 = 200,0 mm

79	 Start/End speed PTO1
81	 Start/End speed PTO2

It determines the value of the start and end speed, i.e. the start speed for the generation of the 
acceleration ramp and the end speed at the end of the deceleration ramp.
1..2147483647 [base 0,1 mm/s], Default: 1000 = 100,0 mm/s

83	 Maximum speed PTO1
85	 Maximum speed PTO2

Determines the value of the maximum displacement speed, i.e. the speed reached at the end of 
the acceleration ramp.
1..2147483647 [base 0,1 mm/s], Default: 20000 = 2000,0 mm/s

87	 Acceleration duration PTO1
88	 Acceleration duration PTO2

Determines the duration of the acceleration ramp
0..1000 [base 0,1 s], Default: 10 = 1,0 s
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89	 Deceleration duration PTO1
90	 Deceleration duration PTO2

Determines the duration of the deceleration ramp
0..1000 [base 0,1 s], Default: 10 = 1,0 s

91	 Damping duration at start/end of acceleration PTO1
92	 Damping duration at start/end of acceleration PTO2

Determines the duration of damping at speed change introduced at the start and end of the 
acceleration ramp
0..600 [base 0,1 s], Default: 5 = 0,5 s

93	 Damping duration at start/end of deceleration PTO1
94	 Damping duration at start/end of deceleration PTO2

Determines the duration of damping at speed change introduced at the start and end of the 
deceleration ramp
0..600 [base 0,1 s], Default: 5 = 0,5 s

95	 Output direction PTO1
96	 Output direction PTO2

Determines which output is used to manage the direction signal in combination with the pulse 
train for managing the stepper motor axis positioning.
0	 Disabled (Default)
1	 Q0.0
2	 Q0.1
3	 Q0.2
4	 Q0.3
5	 Q0.4
6	 Q0.5
7	 Q0.6
8	 Q0.7

 9	 Q1.0
10	 Q1.1
11	 Q1.2
12	 Q1.3
13	 Q1.4
14	 Q1.5
15	 Q1.6
16	 Q1.7

97	 Output direction reversing PTO1
98	 Output direction reversing PTO2

Determines whether the direction output needs to be reversed from its normal operation. In 
normal operation (reversing off), the direction output is switched off for forward movement and 
switched on for reverse movement.
0	 Off
1	 On

99	 Homing input PTO1
100	 Homing input PTO2

Determines which digital input is used during the axis homing procedure to identify the set 
offset loading point.
0	 Disabled
1 	 I0.0
2 	 I0.1
3 	 I0.2
4 	 I0.3
5 	 I0.4
6 	 I0.5
7 	 I0.6
8 	 I0.7
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101	 Homing level input PTO1
102	 Homing level input PTO2

Determines at which input state the home position is detected and the homing procedure is 
completed.
0	 Low level
1 	 High level
	

103	 Homing direction PTO1
104	 Homing direction PTO2

Determines in which direction the axis should move for the home signal search.
0	 backward
1 	 forward

105	 Homing speed PTO1
107	 Homing speed PTO2

Determines the value of the velocity used during homing movement.
1..2147483647 [base 0,1 mm/s], Default: 100 = 10,0 mm/s

109	 Shift homing position PTO1
111	 Shift homing position PTO2

Determines the value that is loaded as the axis position when the home condition occurs 
(homing input active)
-2147483648..2147483647 [base 0,1 mm], Default: 0 = 0,0 mm

7.2	 Digital Inputs
IW0.0	 System digital inputs word

This word contains the status of the 16 digital inputs of the PL280.
Bit 0: I.0.0
…
Bit 7: I.0.7
Bit 8: I.1.0
…
Bit 15: I.1.7

7.3	 Digital Outputs
QW0.0	 System digital outputs word

This word contains the status of the 16 digital outputs of the PL280. To activate the outputs, set 
the corresponding bit on this word to “1”.
Bit 0: Q.0.0
…
Bit 7: Q.0.7
Bit 8: Q.1.0
…
Bit 15: Q.1.7

7.4	 Analog Inputs
AI01  	 System analog input AI1
AI02  	 System analog input AI2
AI03  	 System analog input AI3
AI04  	 System analog input AI4

These words contain the value of the analogue inputs of the PL280. For inputs configured as 
temperature sensors, the value is in tenths of a degree. In the case of an out-of-range, shorted or 
open analogue input, the value reported will be -32768 (short) or 32767 (open).
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7.5	 Analog Outputs
AO01	 System analog output AO1
AO02	 System analog output AO2

These words contain the value of the analogue outputs of the PL280. To set a certain value on 
the corresponding analogue output, write the value on these words in accordance with the 
minimum and maximum output limits set in the parameterisation table.

7.6	 Pulse Train Outputs
System digital outputs PTO WORD

This word contains the status of the PTO outputs of the PL280 when configured in on/off mode. 
To activate the outputs, write the corresponding bit on this word to “1”.
Bit 0: PTO1
Bit 1: PTO2

System Axis Position PTO1
System Axis Position PTO2

These variables contain the position of the axis at the end of positioning

System Set Axis Position PTO1
System Set Axis Position PTO2

These variables contain the axis positioning setpoint. 

System PWM Frequency PTO1
System PWM Frequency PTO2

These variables contain the value of the frequency to be generated by the PTO output when 
configured as PWM.
1…200000Hz

System PWM Duty-cycle PTO1
System PWM Duty-cycle PTO2

These variables contain the duty-cycle value to be generated by the PTO output when configured 
as PWM.
0,00…100,00%

System  PTO1 Command
System  PTO2 Command

These variables are used to send commands to the PTO outputs.
0:  Command ready
1:  Start absolute position
2:  Start relative position
3:  Start velocity movement
4:  Start homing position
5:  Stop position/movement
10:  Start PWM generating
11:  Stop PWM
These variables are automatically reset once the command is received.

System PTO1 state
System PTO2 state

These variables contain the status of the PTO outputs. They can be used as feedback for axis or 
PWM management.
0: Pulse/PWM off
1: Pulse/PWM running
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7.7	 Encoder/counter
EV01 	 System encoder 1 value
EV02 	 System encoder 2 value
EV03 	 System encoder 3 value
EV04 	 System encoder 4 value

These 32-bit variables contain the value in counts of the encoders/counters of the PL280

EC1000_1	 System encoder 1 counts 1s
EC1000_2	 System encoder 2 counts 1s
EC1000_3	 System encoder 3 counts 1s
EC1000_4	 System encoder 4 counts 1s

These 32-bit variables contain the number of encoder/counter counts of the PL280 detected in 
the last second. The data is updated every 1.0s.

EC100_1	 System encoder 1 counts 100ms
EC100_2	 System encoder 2 counts 100ms
EC100_3	 System encoder 3 counts 100ms
EC100_4	 System encoder 4 counts 100ms

These 32-bit variables contain the number of encoder/counter counts of the PL280 detected in 
the last 100ms. The data is updated every 100ms

ECMD_1	 System encoder 1 command
ECMD_2	 System encoder 2 command
ECMD_3	 System encoder 3 command
ECMD_4	 System encoder 4 command

These words are used to send commands to the encoders.
Bit0 = Carica valore preset
Bit1 = Carica preset al prossimo impulso Z
The command bits are automatically set to 0 once command is executed

Notes / Updates
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Introduzione
La gamma di PLC Pixsys PL280 è caratterizzata da una struttura compatta e flessibile.
La CPU PL280, oltre a gestire una serie di I/O integrati, si configura come unità di controllo e nodo 
di connettività, completa di seriale RS485 (Modbus RTU), Ethernet (Modbus TCP/IP), CANopen e bus 
interno real-time su barra DIN. Per la programmazione della logica è disponibile l’ambiente di sviluppo 
LogicLab scaricabile dal sito www.pixsys.net.

1	 Norme di sicurezza
Prima di utilizzare il dispositivo leggere con attenzione le istruzioni e le misure di sicurezza contenute in 
questo manuale. Disconnettere l’alimentazione prima di qualsiasi intervento su connessioni elettriche 
o settaggi hardware al fine di prevenire il rischio di scosse elettriche, incendio o malfunzionamenti. 
Non installare e non mettere in funzione lo strumento in ambienti con sostanze infiammabili, gas o 
esplosivi. Questo strumento è stato progettato e realizzato per l’utilizzo convenzionale in ambienti 
industriali e per applicazioni che prevedano condizioni di sicurezza in accordo con la normativa 
nazionale e internazionale sulla tutela della delle persone e la sicurezza dei luoghi di lavoro. Deve 
essere evitata qualsiasi applicazione che comporti gravi rischi per l’incolumità delle persone o sia 
correlata a dispositivi medici salvavita. Lo strumento non è progettato e realizzato per installazione 
in centrali nucleari, armamenti, sistemi di controllo del traffico aereo o della sicurezza in volo, sistemi 
di trasporto di massa. L’utilizzo/manutenzione è riservato a personale qualificato ed è da intendersi 
unicamente nel rispetto delle specifiche tecniche dichiarate in questo manuale.
Non smontare, modificare o riparare il prodotto né toccare nessuna delle parti interne.
Lo strumento va installato e utilizzato esclusivamente nei limiti delle condizioni ambientali dichiarate. 
Un eventuale surriscaldamento può comportare rischi di incendio e abbreviare il ciclo di vita dei 
componenti elettronici.

1.1	 Organizzazione delle note di sicurezza
Le note sulla sicurezza in questo manuale sono organizzate come segue:
Note di sicurezza Descrizione

Danger! La mancata osservanza di queste linee guida e avvisi di sicurezza 
può essere potenzialmente mortale.

Warning! La mancata osservanza di queste linee guida e avvisi di sicurezza 
può comportare lesioni gravi o danni sostanziali alla proprietà.

Information! Tali informazioni sono importanti per prevenire errori.

1.2	 Note di sicurezza

Danger!
ATTENZIONE - Rischio di incendio e scosse elettriche. Questo prodotto è classificato 
come apparecchiatura di controllo del processo di tipo a barra DIN. Deve essere montato 
in un involucro che non permetta al fuoco di fuoriuscire esternamente.

Danger!

Se i relè di uscita vengono utilizzati oltre la loro aspettativa di vita, possono verificarsi 
occasionalmente fusioni o bruciature dei contatti.
Considerare sempre le condizioni di applicazione e utilizzare i relè di uscita entro il loro 
carico nominale e l’aspettativa di vita elettrica. L’aspettativa di vita dei relè di uscita varia 
notevolmente con il carico in uscita e le condizioni di commutazione.

Warning!
I dispositivi devono essere alimentati a energia limitata secondo UL 61010-1 3rd Ed, 
sezione 9.4 o LPS in conformità con UL 60950-1 o SELV in conformità con UL 60950-1 o 
Classe 2 in conformità con UL 1310 o UL 1585.

Warning! Occasionalmente le viti troppo allentate possono provocare un incendio.  
Per i morsetti a vite, serrare le viti alla coppia di serraggio di 0,22 Nm

Warning!

Un malfunzionamento nel controllore digitale può occasionalmente rendere impossibili 
le operazioni di controllo o bloccare le uscite di allarme, con conseguenti danni 
materiali. Per mantenere la sicurezza, in caso di malfunzionamento, adottare misure di 
sicurezza appropriate; ad esempio con l’installazione di un dispositivo di monitoraggio 
indipendente e su una linea separata.

Indice degli argomenti
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1.3	 Precauzioni per l’uso sicuro
Assicurarsi di osservare le seguenti precauzioni per evitare errori, malfunzionamenti o effetti negativi 
sulle prestazioni e le funzioni del prodotto. In caso contrario, occasionalmente potrebbero verificarsi 
eventi imprevisti. Non utilizzare il controller digitale oltre i valori nominali.

•	 Il prodotto è progettato solo per uso interno. Non utilizzare o conservare il prodotto all’aperto o in 
nessuno dei seguenti posti:
-	 Luoghi direttamente soggetti a calore irradiato da apparecchiature di riscaldamento.
-	 Luoghi soggetti a spruzzi di liquido o atmosfera di petrolio.
-	 Luoghi soggetti alla luce solare diretta.
-	 Luoghi soggetti a polvere o gas corrosivi (in particolare gas di solfuro e gas di ammoniaca).
-	 Luoghi soggetti a forti sbalzi di temperatura.
-	 Luoghi soggetti a formazione di ghiaccio e condensa.
-	 Luoghi soggetti a vibrazioni e forti urti.

•	 L’utilizzo di due o più controller affiancati o uno sopra l’altro possono causare un incremento di 
calore interno che ne riduce il ciclo di vita. In questo caso si raccomanda l’uso di ventole per il 
raffreddamento forzato o altri dispositivi di condizionamento della temperatura interno quadro.

•	 Controllare sempre i nomi dei terminali e la polarità e assicurarsi di effettuare una cablatura corretta.
Non collegare i terminali non utilizzati.

•	 Per evitare disturbi induttivi, mantenere il cablaggio dello strumento lontano da cavi di 
potenza con tensioni o corren ti elevate. Inoltre, non collegare linee di potenza insieme o in 
parallelo al cablaggio del controller digitale. Si consiglia l’uso di cavi schermati e condotti 
separati. Collegare un limitatore di sovratensione o un filtro antirumore ai dispositivi che 
generano rumore (in particolare motori, trasformatori, solenoidi, bobine o altre apparecchia-
ture con componenti induttivi). Quando si utilizzano filtri antidisturbo sull’alimentazione, 
controllare tensione e corrente e collegare il filtro il più vicino possibile allo strumento. 
Lasciare più spazio possibile tra il controller e dispositivi di potenza che generano alte frequenze 
(saldatrici ad alta frequenza, macchine per cucire ad alta frequenza, ecc.) o sovratensioni.

•	 Un interruttore o un sezionatore deve essere posizionato vicino al regolatore. L’interruttore o il 
sezionatore deve essere facilmente raggiungibile dall’operatore e deve essere contrassegnato 
come mezzo di disconnessione per il controller.

•	 Rimuovere lo sporco dallo strumento con un panno morbido e asciutto. Non usare mai diluenti, 
benzina, alcool o detergenti che contengano questi o altri solventi organici. Possono verificarsi 
deformazioni o scolorimento.

•	 Il numero di operazioni di scrittura della memoria non volatile è limitato. Tenere conto di questo 
quando si utilizza la modalità di scrittura in EEprom ad esempio nella variazione dei dati durante le 
comunicazioni seriali.

1.4	 Tutela ambientale e smaltimento dei rifiuti / Direttiva 
WEEE

Non smaltire le apparecchiature elettriche ed elettroniche tra i rifiuti domestici.
Secondo al Direttiva Europea 2012/19/EU le apparecchiature esauste devono essere raccolte 
separatamente al fine di essere reimpiegate o riciclate in modo eco-compatibile.

2	 Identificazione del modello
La serie PL280 prevede una versione

PL280-1AD PLC DIN RAIL 1 ETHERNET; 1 RS485; 1 CANopen; 1 PLE DIN BUS
4 Analog inputs; 2 Analog Outputs; 24 Digital I/Os; 2 Pulse train Outputs
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3	 Dati tecnici
3.1	 Caratteristiche generali
Tensione alimentazione 12..24 VDC ± 10%
Consumo 5W
Condizioni operative Temperatura: 0-45°C; umidita 35..95 RH% senza condensa
Contenitore 162 x 90 x 64 mm - 9 moduli DIN43880 
Materiali Contenitore: Noryl V0;  Frontale: gomma siliconica V0 autoestinguenti
Protezione IP20 (contenitore e morsettiere)
Peso Circa 130 g

3.2	 Caratteristiche hardware
CPU ARM Cortex H7 @ 480MHz
Memoria Flash 2 Mb / RAM 1 Mb

Ingressi digitali 16 ingressi PNP 12-24Vdc
(8 sovrapposti alle uscite digitali)

V
IL

 = 4,4V
V

IH
 = 8,2V

Ingressi encoder/
contatore

4 encoder/contatori sovrapposti agli
ingressi digitali PNP

Risoluzione 32 bit
Frequenza massima 100KHz

Ingressi analogici

4 ingressi configurabili via software
Termocoppie: tipo K, S, R, J, T, E, N, B; con 
compensazione automatica del giunto freddo 
da 0..50°C.
Termoresistenze: PT100, PT500,
PT1000, Ni100, PTC1K, NTC10K (β 3435K)
Ingresso VI: 0-10V, 0-20 o 4-20mA,
0-60mV, 0-1V, 0-5V
Potenziometri: 1..150 kΩ

Tolleranza: (@ 25 °C)
± 0.2% ± 1 digit (su F.s.)
Risoluzione: 16bit

Uscite digitali 16 uscite statiche 12-24Vdc
(8 sovrapposte agli ingressi digitali)

Max 700mA per uscita
Max 2A in totale per ciascun 
gruppo di 8 uscite (Q.0.0-
Q.0.7 e Q.1.0-Q.1.7)

Uscite analogiche 2 uscite configurabili via software:
0-10V o 4-20mA Risoluzione: 16bit

Uscite PTO (Pulse 
Train Output)

2 uscite configurabili via software:
On/Off, PTO o PWM 12.24V DC

Max 20mA for each output
Max frequency 200KHz

Porta COM1/RS485 RS485 con prot. Modbus RTU master/slave Fino a 115200 baud
Porta CAN1 CANopen CAN con protocollo CANopen master Fino a 1Mbit
Bus PLCEXP Comunicazione realtime con moduli di espansione serie PLE500-xx
Porta Ethernet Con protocollo Modbus TCP master/slave

3.3	 Caratteristiche software
Tempo ciclo minimo 1mS
Public objects - 
Parameters (non-volatile) 3800 words, ritenzione dati 150 anni 

Public objects - 
Status variables (volatile) 4096 words

Ritenzione Variabili 2KB 60 giorni di ritenzione con batteria ricaricabile a condensatore
Ritenzione Datablock 2KB 60 giorni di ritenzione con batteria ricaricabile a condensatore
PLC code size 476KB
PLC data size 128KB

Modbus TCP Master Max. slave: 16
Max. word in lettura: 2048 - Max. word in scrittura: 2048

Modbus RTU Master Max. slave: 120
Max. word in lettura: 1024 - Max. word in scrittura: 1024
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4	 Dimensioni ed installazione

4.1	 Sequenza di montaggio del PL280 e dei moduli di 
espansione PLE500

Il PL280 con i relativi moduli di I/O prevede il montaggio e la connessione tramite apposito bus 
alloggiato nell’incavo della barra DIN. I moduli di I/O (serie PLE500-xAD) verranno automaticamente 
numerati ad ogni accensione, assegnando il numero 1 al primo modulo I/O collegato alla destra 
del PL280, il numero 2 a quello seguente e così via, procedendo sempre verso destra. La posizione 
dei vari moduli dovrà quindi rispecchiare la sequenza impostata nel progetto di LogicLab nella 
definizione della rete PLCEXP. Perché la procedura di numerazione possa funzionare correttamente, 
non è consentito rimuovere dispositivi dalla rete sganciandoli dal proprio bus e lasciando dei moduli 
vuoti (slot bus) tra un modulo e l’altro. Tutte le operazioni di connessione/sconnessione devono essere 
effettuate in assenza di tensione.

Clik!
Agganciare tutti i bus premendoli verso la barra DIN, 
prestando attenzione che la connessione maschio sia a 
rivolta verso sinistra e la femmina verso destra.

Agganciare tutti i bus tra loro facendoli scorrere sulla 
barra DIN.
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Inserire negli slot dei bus i vari moduli, iniziando dal 
PL280 e proseguendo verso destra con i moduli di I/O.
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Procedere con il montaggio di tutti i moduli 
nell’ordine richiesto fino alla completa composizione 
del plc.
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Non è possibile lasciare slot liberi nel bus tra un 
modulo e l’altro.

5	 Collegamenti elettrici
Questo strumento è stato progettato e costruito in conformità alle Direttive Bassa Tensione 2006/95/ 
CE , 2014/35/UE (LVD) e Compatibilità elettromagnetica 2004/108/CE e 2014/30/UE (EMC) per l’installa- 
zione in ambienti industriali è buona norma seguire la seguenti precauzioni:
•	 Distinguere la linea di alimentazioni da quelle di potenza.
•	 Evitare la vicinanza di gruppi di teleruttori, contattori elettromagnetici, motori di grossa potenza e 

comunque usare appositi filtri.
•	 Evitare la vicinanza di gruppi di potenza, in particolare se a controllo di fase.
•	 Si raccomanda l’impiego di filtri di rete sull’alimentazione della macchina in cui lo strumento verrà 

installato, in particolare nel caso di alimentazione 230 VAC.                   
	 Si evidenzia che lo strumento è concepito per essere assemblato ad altre macchine e dunque la 

marcatura CE dello strumento non esime il costruttore dell’impianto dagli obblighi di sicurezza e 
conformità previsti per la macchina nel suo complesso.

•	 Per cablare i morsetti utilizzare puntalini a tubetto crimpati o filo di rame flessibile o rigido di 
sezione compresa tra 0.25 e 1.5 mm2 (min. AWG28, max. AWG16, temperatura operativa: min. 70°C). 
La lunghezza di spelatura è compresa tra 7 e 8 mm.

5.1	 Schema di collegamento
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PL280-1AD

5.1.a	 Alimentazione

1
–

SUPPLY
12..24 VDC

2

+

3
12...24VDC
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5.1.b	 Uscite analogiche AO1, AO2

AO.2
6

7

+

–

AO V
mA

Shield / Schermo

AO.1
4

5

Configurabile:
0-10 V con 30000 punti ±0.3% (su F.S.) @25 °C;
carico >= 1 KΩ
4-20 mA con 25000 punti ±0.3% (su F.S.) @25 °C;
carico <= 500Ω

5.1.c	 Uscite Pulse Train PTO1 e PTO2

PTO.2
9

2

+

–

PTO.1
8

2

Configurabili in tre modalità operative:
On/Off -Attivazione in modalità on/off senza logiche preimpostate.
PTO - Gestione posizionamento asse per motori passo passo (con 
generazione rampe di accelerazione e decelerazione)
PWM - Uscita PWM con frequenza e duty-cycle variabile (Frequenza 
1÷200000Hz, duty-cycle 0,00 ÷ 100,00%)

5.1.d	 Ingressi analogici per termocoppie

AI1
+

–

AI TC
11

10

AI2

14

13

AI3

17

16

AI4

20

19

Termocoppie K, S, R, J, T, E, N, B
Rispettare la polarità
Per eventuali prolunghe utilizzare cavo compensato e morsetti adatti 
alla termocoppia utilizzata (compensate)

5.1.e	 Ingressi analogici per termoresistenze PT100, NI100
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/N

I1
00

11

10

12

14

13

15

17

16

18

20

19

21

Per il collegamento a tre fili usare cavi della stessa sezione
Per il collegamento a due fili cortocircuitare i morsetti 11 e 12 (AI1), 14 
e 15 (AI2), 17 e 18 (AI3), 20 e 21 (AI4). 

RED
ROSSO

RED
ROSSO

WHITE
BIANCO 10

11

12

5.1.f	 Ingressi analogici per termoresistenze NTC, PTC

AI1 AI2

13

15

AI3

16

18

AI4

19

21
AI PT

C/
NT

C

10

12

Termoresistenze tipo NTC-10K, PTC-1K, PT500 e PT1000
Potenziometri lineari

5.1.g	 Ingressi analogici per segnali normalizzati

AI1 AI2 AI3 AI4
+

–

AI V
mA

11

10

14

13

17

16

20

19

Segnali in tensione 0..10V, 0..1V, 0..5V, 0..60mV
Segnali in corrente 0..20 mA, 4..20mA

5.1.h	 Uscite digitali statiche PNP 24Vdc

22 23 28.. 29
Q.0.0VDC- Q.0.1 Q.0.6 Q.0.7 22: Uscita Q0.0

23: Uscita Q0.1
24: Uscita Q0.2
25: Uscita Q0.3

26: Uscita Q0.4
27: Uscita Q0.5
28: Uscita Q0.6
29: Uscita Q0.7



Manuale d’uso - PL280- 31

5.1.i	 Positivo alimentazione uscite statiche Q0.0÷ Q0.7

30
+VDC

12..24 VDC
Alimentazione per il blocco di uscite

5.1.j	 Ingressi digitali PNP 24Vdc

12..24 VDC I0.1 I0.2 I0.6 I0.7
36 37 42.. 43

36: Ingresso I0.0
37: Ingresso I0.1
38: Ingresso I0.2
39: Ingresso I0.3

40: Ingresso I0.4
41: Ingresso I0.5
42: Ingresso I0.6
43: Ingresso I0.7

5.1.k	 Ingressi digitali PNP 24Vdc / Uscite statiche 24Vdc

45 46 51.. 52

I/Q
1.

0

I/Q
1.

1

I/Q
1.

6

I/Q
1.

7

12..24 VDC

- VDC

45: Ingresso/Uscita I/Q1.0
46: Ingresso/Uscita I/Q1.1
47: Ingresso/Uscita I/Q1.2
48: Ingresso/Uscita I/Q1.3

49: Ingresso/Uscita I/Q1.4
50: Ingresso/Uscita I/Q1.5
51: Ingresso/Uscita I/Q1.6
52: Ingresso/Uscita I/Q1.7

5.1.l	 Positivo alimentazione uscite statiche Q1.0÷ Q1.7

53
+VDC

12..24 VDC
Alimentazione per il blocco di uscite

5.1.m	 Ingressi encoder Push-Pull
ENC2

38
ENC3

40
ENC4

42A

B

Z
+- SUPPLY

ENC1

36
39 41 4337
46 47 4845EN

CO
DE

R Usare solo encoder di tipo push-pull
Frequenza massima 100KHz

5.1.n	 Ingressi contatore

CNT2

38
CNT3

40
CNT4

42
+- SUPPLY

CNT1

36 Ingressi PNP
Frequenza massima 100KHz

5.1.o	 Seriale COM1/RS485

CA-B+

313 32 33 31: (B+) RS485+
32: (A-) RS485-
33: (C) Riferimento 
Collegare l’eventuale schermo del cavo al morsetto 3.

5.1.p	 Bus CAN1

CCANLCANH

353 34 33 CAN MASTER:
35: (H) CanH
34: (L) CanL
33: (C) Riferimento 
Collegare l’eventuale schermo del cavo al morsetto 3.
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5.1.q	 Ethernet

Porta Ethernet 10/100 Mbit per la programmazione dal software di 
sviluppo e connettività di rete.

5.1.r	 PLE / DIN bus

Connettore bus da alloggiare nell’incavo della barra DIN per 
connettere gli eventuali moduli I/O al PL500. Per la sequenza di 
montaggio, vedere paragrafo 1.2.

5.1.s	 USB

Porta USB 2.0 per Backup / Restore degli applicativi e delle funziona-
lità di archiviazione di massa (la memory deve essere formattata in 
FAT/FAT32).

5.1.t	 Pulsante S1 per Backup / Restore del sistema (interno)
Backup:
La procedura di backup consente di salvare la configurazione completa del 
dispositivo su una memoria USB sia del codice e sia delle memorie retintive.
1 - Accendere il PLC.
2 - Inserire una memoria USB (esterna).
3 - Aprire il coperchio frontale e premere il pulsante S1 per circa 8 secondi (si 
accende il led verde CONFIRM)
4 - Rilasciare il pulsante S1
5 - Attendere il completamento della procedura di Backup.
Durante la procedura il led RUN rosso lampeggia e l’avanzamento della 
procedura viene indicato dall’accensione in sequenza dei led da I.0.0 fino a 
I/Q.1.7. Il led COM giallo indica la presenza della memoria USB.
Al termine della procedura il Led RUN verde si accende fisso.
In caso di errori durante la procedura, il Led RUN rosso si accende fisso.
6 - Spegnere il PLC, togliere la memoria USB e riaccendere il device.

Nel caso il programma sul PLC fosse protetto da password, è necessario inserire nella root della 
memoria USB un file Password.txt contenente la password di protezione del programma altrimenti 
la procedura di backup non verrà eseguita. Una volta eseguito il backup il file può essere rimosso 
dalla memoria.
Al termine del backup verrà generato nella root della memoria USB un file BackupLog.txt contenente 
l’esito della procedura.

Restore:
1 - Inserire una memoria USB contenente il Backup con il PLC spento.
2 - Accendere il PLC tenendo premuto il pulsante S1 (il led verde CONFIRM si 
accende).
3 - Attendere il completamento della procedura di Restore.
Durante la procedura il led RUN rosso lampeggia e l’avanzamento della 
procedura viene indicato dall’accensione in sequenza dei led da I.0.0 fino a 
I/Q.1.7. Il led COM giallo indica la presenza della memoria USB.
Al termine della procedura il Led RUN verde si accende fisso.
In caso di errori durante la procedura, il LEd RUN rosso si accende fisso.
5 - Spegnere il PLC, togliere la memoria USB e riaccendere il device.
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5.2	 Significato delle spie di stato
 RUN Acceso fisso indica che il PLC è nello stato di STOP
 RUN Acceso fisso indica il normale funzionamento del PLC

 RUN Lampeggiante in modo alternato ogni 0,5s indica che è in corso la procedura di 
discovery del dispositivo

 COM Si accende per 100 ms ad ogni invio di un frame di comunicazione sulla porta COM1/
RS485

 AO1...2 Acceso indica che l’uscita analogica corrispondente è attiva
 PTO1...2 Acceso indica che l’uscita pulse train output corrispondente è attiva

 AI1...4

Acceso fisso indica che l’ingresso analogico corrispondente è attivo e sta funzionando 
correttamente.
Lampeggiante indica che l’ingresso analogico corrispondente si trova in uno stato di 
errore. Potrebbe trattarsi di una sonda non di tipo corretto, scollegata, in corto o fuori 
range.

 I.0.0...7 Acceso indica che l’ingresso digitale corrispondente è attivo
 Q.0.0...7 Acceso indica che l’uscita digitale corrispondente è attiva
 I/Q.0.0...7 Acceso indica che l’ingresso o l’uscita digitale corrispondente sono attivi

6	 Suite LogicLab
La Suite LogicLab è l’ambiente di sviluppo di Pixsys per la programmazione del PLC PL280 e di tutta la 
famiglia di terminali operatore e PanelPC.
La suite è scaricabile dall’area download del sito pixsys.net, previa registrazione e non necessita di 
codici di attivazione. È compatibile con tutte le versioni di Windows 32/64bit a partire da Windows 
XP SP3 ed è disponibile in lingua inglese e in italiano. Una volta scaricato il file di setup sul proprio 
computer, avviare l’installazione e seguire la procedura standard. Una volta installato il programma, 
si avvia tramite l’icona ”LogicLab”  sul desktop oppure dal menù “Start” > “PixsysSuite” > “LogicLab”.

6.1	 Cambio lingua
Per cambiare la lingua di visualizzazione è necessario 
aprire la finestra delle opzioni dal menù “File” > 
“Options”, passare alla scheda “Language”, selezionare 
la voce “ITA - italiano” e premere “Select”. Confermare 
quindi con “OK”
ed infine chiudere e riaprire LogicLab affinchè le 
modifiche abbiano effetto.

6.2	 Creazione - caricamento di un progetto

Schermata iniziale di LogicLab
•	 Una volta avviata l’applicazione, si presentano 

una serie di opzioni per creare o  aprire un 
progetto, eseguire una scansione della rete 
per rilevare i dispositivi connessi riconosciuti 
dall’ambiente di sviluppo o selezionare uno dei 
dispositivi.
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Scansione della rete…
•	 Facendo click sul pulsante Scan Network,  

LogicLab esegue una ricerca di tutti i dispositivi 
programmabili presenti sulla rete e va a compilare 
la tabella “Scan result”

•	 In base al tipo di dispositivo rilevato, tramite 
i pulsanti presenti nella tabella sono possibili 
alcune operazioni direttamente sul dispositivo 
selezionato.

•	 Per il PL280, tramite il pulsante  è possibile 
avviare la modalità discovery sul dispositivo 
selezionato, che consiste nel far lampeggiare il 
led RUN in modo alternato rosso/verde per circa 
5 secondi, in modo da poter stabilire con certezza 
se si tratta del giusto dispositivo nel caso ne siano 
stati rilevati più di uno dello stesso tipo durante la 
scansione.

•	 Per il PL280, tramite il pulsante  è possibile 
aprire una schermata in cui modificare le 
impostazioni di rete del dispositivo.

Apertura di un progetto esistente:
•	 Con LogicLab aperto, fare click sul pulsante “Apri 

progetto” oppure selezionare uno degli ultimi 
progetti aperti dall’elenco proposto.

•	 Con LogicLab chiuso, entrare nella cartella del 
progetto e fare doppio click sul file con il nome 
del progetto desiderato che avrà l’icona  ed 
estensione “.plcprj”.

Creare un nuovo progetto:
•	 Premere il pulsante “Nuovo Progetto” oppure, dalla 

tabella “Scan result” selezionare il dispositivo su 
cui si intende lavorare e premere il pulsante .

•	 Nella finestra che appare, digitare un nome per il 
progetto ed identificare la cartella dove verranno 
inseriti i file del progetto. Selezionare infine il 
dispositivo che si vuole programmare.

Attenzione: selezionando il flag “rispetta maiuscole/minuscole”, una variabile che contiene una 
lettera maiuscola sarà intesa come diversa da un’altra di uguale nome ma con tale lettera minuscola. 
Consigliamo quindi di lasciare disabilitata tale selezione, per evitare confusione durante la stesura del 
codice programma.

6.3	 Collegamento al target
Si elencano di seguito i requisiti necessari per il corretto collegamento tra target (dispositivo da 
programmare) e l’ambiente di sviluppo su PC (LogicLab).

Requisiti da verificare sul target:
•	 dispositivo acceso e avviato
•	 configurato con indirizzo IP statico compatibile con la rete dove si trova ed il PC con cui si dovrà 

connettere. Di default, l’indirizzo IP del PL280 è 192.168.0.99, quindi il PC dove si sta sviluppando 
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dovrà avere la stessa rete e classe (in questo caso 192.168.0.XXX) ma indirizzo fisico diverso (cioè 
le ultime 3 cifre dell’indirizzo IP, con un qualsiasi numero compreso tra 1 e 255, diverso da 99). 
Se è necessario cambiare l’indirizzo IP del PL280 rispetto a quello di default, fare riferimento alle 
indicazioni riportate nel paragrafo precedente.

•	 connessione con cavo di rete (diretto o cross) direttamente al PC o attraverso uno switch di rete

Requisiti da verificare sul PC di sviluppo:
•	 indirizzo IP compatibile con la rete esistente dove si trova e con l’indirizzo IP configurato nel 

target (vedi punti precedenti)
•	 antivirus/firewall che permetta la connessione a dispositivi nella rete (di norma sono già 

configurati correttamente)
•	 LogicLab configurato per connettersi al target collegato che si vuole programmare: per fare ciò, 

navigare sul menù “On Line” > “Imposta comunicazione” e nella finestra che appare, premere il 
pulsante “Properties” e poi alla voce “IP Address” inserire l’indirizzo IP del target, lasciando inalterato 
tutto il resto. Nel caso di reti molto lente o di una configurazione di rete con diversi switch, è 
possibile aumentare il valore “Timeout” (espresso in mS).

L’immagine rappresenta la configurazione di default

Confermare tutte le finestre premendo su “OK” e salvare attraverso l’icona  o attraverso il menù “file”
> “Salva Progetto”.
A questo punto, per verificare che la configurazione del LogicLab e del target sia corretta, si può 
effettuare la connessione premendo l’icona  oppure dal menù “On Line” > “Connetti”. Se la 
connessione va a buon fine la barra di stato in basso a destra visualizzerà “CONNESSO” e “NO CODICE” 
ad indicare che il target è connesso e non ha codice al suo interno oppure “CODICE DIFF” ad indicare 
che il codice che si sta visualizzando non corrisponde a quello che risiede nel target.

6.4	 Compilazione e scaricamento del codice
Una volta inserito il codice progetto è necessario compilarlo per verificare che non ci siano errori, 
premendo il tasto F7, attraverso l’icona  oppure dal menù “Progetto” > “Compila”.
Se la compilazione va a buon fine si può trasferire il programma al target premendo il tasto F5, 
attraverso l’icona  oppure dal menù “On Line” > “Trasferimento codice”.
A questo punto la barra di stato visualizzerà “CONNESSO” e “SORGENTE OK” indicando che il programma 
in esecuzione nel target corrisponde a quello che si sta visualizzando sul PC.
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6.5	 La watch window
Se il programma in esecuzione nel target corrisponde a quello che si sta visualizzando sul PC, la barra 
di stato visualizza “CONNESSO” e “SORGENTE OK” ed è quindi possibile utilizzare la finestra di “Watch” 
per verificare, in tempo reale, lo stato delle variabili utilizzate nel progetto. Per abilitare la finestra di 
“Watch”, premere i tasti CTRL+T oppure usare il menù “Vista” > “Finestra strumenti” > “Watch”. 
Per aggiungere una variabile alla finestra di “Watch” è sufficiente trascinarla al suo interno oppure 
premere l’icona  e selezionarla manualmente.

Da questo momento, la finestra di “Watch” comincerà 
a visualizzare il valore della variabile inserita, in tempo 
reale.

Attraverso gli appositi pulsanti  è possibile inoltre salvare, caricare e aggiungere all’elenco 
delle variabili, una watch-list già esistente.

Se si desidera cambiare il formato di visualizzazione, è 
sufficiente selezionare la variabile e premere l’icona 
Dalla finestra che appare selezionare quindi il formato 
desiderato e confermare con “OK”.

7	 Le risorse locali del PL280 “Local IO Mapping“
Le risorse hardware disponibili nel PL280 sono disponibili nella sezione “Local IO Mapping” del 
programma, suddivise per categorie in modo da renderne più fruibile ed agevole l’utilizzo. La sezione 
“Parametrization” permette di impostare tutti i parametri che regolano il funzionamento del PL280. 
La configurazione dei parametri viene automaticamente gestita nella fase di inizializzazione del PLC. 
Ulteriori modifiche dei parametri “al volo” durante l’esecuzione del programma devono essere rese 
attive richiamando la funzione di sistema “sysApplyIOConfiguration(0);”
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La gestione delle “Local IO Mapping” permette di 
mappare su delle variabili utilizzabili dal programma 
tutte le risorse locali disponibili nel PL280.

7.1	 Parametrization
1	 Tipo sensore AI1
2	 Tipo sensore AI2
3	 Tipo sensore AI3
4	 Tipo sensore AI4

Configurazione ingresso analogico / selezione sensore
 0	 Disabilitato (Default)
 1 	 Tc K	 -260 °C..1360 °C
 2	 Tc S	 -40 °C..1760 °C
 3	 Tc R	 -40 °C..1760 °C
 4 	 Tc J 	 -200 °C..1200 °C
 5 	 Tc T 	 -260 °C..400 °C
 6 	 Tc E 	 -260 °C..980 °C
 7 	 Tc N 	 -260 °C..1280 °C
 8 	 Tc B 	 100 °C..1820 °C
 9 	 PT100 	 -100 °C..600 °C
10 	 NI100 	 -60 °C..180 °C
11 	 NTC-10K 	 -40 °C..125 °C 
12 	 PTC-1K 	 -50 °C..150 °C
13 	 PT500 	 -100 °C..600 °C
14 	 PT1000  	 -100 °C..600 °C
15 	 0..1V
16 	 0..5V
17 	 0..10V
18 	 0..20mA
19 	 4..20mA
20 	 0..60mV
21 	 Potenziometer (impostare il valore nel parametro 14..17)
22	 Counts PGA 64
23	 Counts PGA 128

5	 Tipo Gradi
0	 °C 	 (Celsius) (Default)
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1	 °F 	 (Fahrenheit)
2	 K 	 (Kelvin)

6	 Limite inferiore ingresso AI1
7	 Limite inferiore ingresso AI2
8	 Limite inferiore ingresso AI3
9	 Limite inferiore ingresso AI4

Limite inferiore dell’ingresso analogico solo per normalizzati. Es: con ingresso 4..20 mA questo 
parametro indica il valore associato a 4 mA
-32768..+32767, Default: 0.

10	 Limite superiore ingresso AI1
11	 Limite superiore ingresso AI2
12	 Limite superiore ingresso AI3
13	 Limite superiore ingresso AI4

Limite superiore dell’ingresso analogico solo per normalizzati. Es: con ingresso 4..20 mA questo
parametro indica il valore associato a 20 mA
-32768..+32767, Default: 1000

14	 Valore potenziometro AI1
15	 Valore potenziometro AI2
16	 Valore potenziometro AI3
17	 Valore potenziometro AI4

Seleziona il valore del potenziometro collegato all’ingresso analogico.
1..150 kohm, Default: 10kohm

18	 Limite lineare oltre ingresso AI1
19	 Limite lineare oltre ingresso AI2
20	 Limite lineare oltre ingresso AI3
21	 Limite lineare oltre ingresso AI4

In caso di ingresso lineare, permette al processo di superare i limiti (Par. 6..9 e 10..13).
0 Off
1 On

22	 Calibrazione offset AI1
23	 Calibrazione offset AI2
24	 Calibrazione offset AI3
25	 Calibrazione offset AI4

Calibrazione offset. Valore che si somma o sottrae al processo visualizzato (es: normalmente
corregge il valore di temperatura ambiente).
-10000..+10000 [digit] (gradi.decimi per sensori di temperatura). Default 0.

26	 Calibrazione guadagno AI1
27	 Calibrazione guadagno AI2
28	 Calibrazione guadagno AI3
29	 Calibrazione guadagno AI4

Calibrazione guadagno. Valore che si moltiplica al processo per eseguire calibrazione sul punto
di lavoro. Es: per correggere la scala di lavoro da 0..1000°C che visualizza 0..1010°C, fissare il
parametro a -1.0
-1000 (100.0%)...+1000 (+100.0%), Default: 0.0.

30	 Riservato
31	 Riservato
32	 Riservato
33	 Riservato
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34	 Filtro ingresso AI1
35	 Filtro ingresso AI2
36	 Filtro ingresso AI3
37	 Filtro ingresso AI4

Filtro lettura ingresso analogico: aumenta la stabilita del valore della lettura analogica. Indica il
numero di campionamenti da mediare nel calcolo del processo.
1...50. (Default: 10)

38	 Massima differenza per nuovo campionamento AI1
39	 Massima differenza per nuovo campionamento AI2
40	 Massima differenza per nuovo campionamento AI3
41	 Massima differenza per nuovo campionamento AI4

Definisce il valore assoluto massimo di differenza tra il valore attuale del processo e il nuovo
campionamento per ritenere tale valore accettabile (e quindi inserito nella media gestita dal
parametro “34..37 Filtro ingresso”) o scartarlo.
1..32767 [decimi di °C o digit], Default: 10,0 °C

42	 Durata massima scarto campionamento AI1
43	 Durata massima scarto campionamento AI2
44	 Durata massima scarto campionamento AI3
45	 Durata massima scarto campionamento AI4

Determina la durata massima per la quale i campionamenti dell’ingresso analogico possono
venire scartati se considerati non accettabili (vedi parametri 70..73). Scaduto tale tempo qualsiasi
valore di campionamento verra considerato valido.
0..200 [decimi di secondo], Default: 1,0 s

46	 Frequenza conversione AI1, AI2
47	 Frequenza conversione AI3, AI4

Frequenza di conversione del il convertitore analogico digitale. Frequenze piu basse rallentano il 
campionamento ma aumentano la precisione di lettura, mentre frequenze piu alte aumentano il 
tempo di campionamento a scapito della precisione di lettura dell’ingresso analogico.
0	 4 Hz
1	 6 Hz
2	 8 Hz
3	 10 Hz
4	 12 Hz
5	 17 Hz (Default)
6	 20 Hz

 7	 33 Hz
 8	 39 Hz
 9	 50 Hz
10	 62 Hz
11	 123 Hz
12	 242 Hz
13	 470 Hz

48	 Filtro ingresso digitale
Definisce il tempo per cui l’ingresso digitale deve rimanere stabile prima di essere considerato
valido.
0..250 [base 1,0 ms], Default: 5 x 1,0 = 5 ms.

49	 Encoder/contatore setup 1
50	 Encoder/contatore setup 2
51	 Encoder/contatore setup 3
52	 Encoder/contatore setup 4

Determina la modalità di funzionamento dell’ingresso encoder o contatore monodirezionale.
0	 Disable
1 	 Encoder x2 phase A-B
2 	 Encoder x4 phase A-B
3 	 Encoder x2 phase A-B-Z
4 	 Encoder x4 phase A-B-Z
5 	 Counter Up
6 	 Counter Down(non permessa per P052)
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53	 Encoder/contatore preset 1
55	 Encoder/contatore preset 2
57	 Encoder/contatore preset 3
59	 Encoder/contatore preset 4

Determina il valore che verrà caricato nel registro dei conteggi dell’encoder o del contatore, al 
verificarsi del comando di caricamento.
-2147483648..2147483647  [digit], Default: 0.

61	 Tempo offline
Determina il tempo in ms impiegato dal plc per attivare le uscite di “errore” nel caso di interruzione 
della comunicazione con l’I/O integrato.
0 Off
1 to 60000 time in ms

62	 Q0.0÷I/Q1.7 valore output in errore
Determina il valore dell’uscita pulse train in caso di errore o anomalia.
Il valore deve essere compreso tra i limiti minimo e massimo dell’uscita..
-32768..+32767 [digit], Default: 0.

63	 Tipo uscita AO1
64	 Tipo uscita AO2

Seleziona la modalità di funzionamento dell’uscita analogica.
0	 0-10 V (Default)
1	 4-20 mA

65	 Limite inferiore uscita AO1
66	 Limite inferiore uscita AO2

Limite inferiore range uscita continua (valore associato a 0V o 4mA).
-32768...+32767 [digit], Default: 0.

67	 Limite superiore uscita AO1
68	 Limite superiore uscita AO2

Limite superiore range uscita continua (valore associato a 10V o 20mA).
-32768...+32767 [digit], Default: 1000.

69	 A01 valore output in errore
70	 A02 valore output in errore

Determina il valore dell’uscita analogica in caso di errore o anomalia.
Il valore deve essere compreso tra i limiti minimo e massimo dell’uscita.
-32768..+32767 [digit], Default: 0.

71	 Tipo uscita PTO1
72	 Tipo uscita PTO2

Seleziona la modalità di funzionamento dell’uscita PTO (Pulse Train Output).
0	 Out On/Off (Default)
1	 Out PTO
2	 Out PWM

73	 Impulsi per giro motore PTO1
74	 Impulsi per giro motore PTO2

Imposta il numero di impulsi da generare per far compiere al motore passo passo un giro completo.
1..32000 [impulsi], Default: 200.
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75	 Movimento del carico per giro del motore PTO1
77	 Movimento del carico per giro del motore PTO2

Determina il valore dello spostamento fisico dell’asse per ciascun giro completo del motore. 
1..2147483647 [base 0,1 mm], Default: 2000 = 200,0 mm

79	 Velocità di inizio/fine PTO1
81	 Velocità di inizio/fine PTO2

Determina il valore della velocità di inizio e fine spostamento, cioè la velocità di partenza per la 
generazione della rampa di accelerazione e quella finale al termine della rampa di decelerazione.
1..2147483647 [base 0,1 mm/s], Default: 1000 = 100,0 mm/s

83	 Velocità massima PTO1
85	 Velocità massima PTO2

Determina il valore della velocità massima di spostamento, cioè la velocità raggiunta al termine 
della rampa di accelerazione.
1..2147483647 [base 0,1 mm/s], Default: 20000 = 2000,0 mm/s

87	 Durata accelerazione PTO1
88	 Durata accelerazione PTO2

Determina la durata della rampa di accelerazione
0..1000 [base 0,1 s], Default: 10 = 1,0 s

89	 Durata decelerazione PTO1
90	 Durata decelerazione PTO2

Determina la durata della rampa di decelerazione
0..1000 [base 0,1 s], Default: 10 = 1,0 s

91	 Durata smorzamento a inizio/fine accelerazione PTO1
92	 Durata smorzamento a inizio/fine accelerazione PTO2

Determina la durata dello smorzamento alla variazione della velocità introdotto nella fase iniziale 
e finale della rampa di accelerazione
0..600 [base 0,1 s], Default: 5 = 0,5 s

93	 Durata smorzamento a inizio/fine decelerazione PTO1
94	 Durata smorzamento a inizio/fine decelerazione PTO2

Determina la durata dello smorzamento alla variazione della velocità introdotto nella fase iniziale 
e finale della rampa di decelerazione
0..600 [base 0,1 s], Default: 5 = 0,5 s

95	 Direzione uscita PTO1
96	 Direzione uscita PTO2

Determina quale uscita è utilizzata per la gestione del segnale di direzione in abbinata al treno di 
impulsi per la gestione del posizionamento dell’asse del motore passo passo.
0	 Disabled (Default)
1	 Q0.0
2	 Q0.1
3	 Q0.2
4	 Q0.3
5	 Q0.4
6	 Q0.5
7	 Q0.6
8	 Q0.7

 9	 Q1.0
10	 Q1.1
11	 Q1.2
12	 Q1.3
13	 Q1.4
14	 Q1.5
15	 Q1.6
16	 Q1.7
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97	 Inversione direzione uscita PTO1
98	 Inversione direzione uscita PTO2

Determina se l’uscita di direzione necessita dell’inversione rispetto al suo normale funzionamento. 
Nel normale funzionamento (inversione off), l’uscita di direzione viene disattivata per il 
movimento avanti e attivata per il movimento indietro.
0	 Off
1	 On

99	 Homing ingresso PTO1
100	 Homing ingresso PTO2

Determina quale ingresso digitale viene utilizzato durante la procedura di homing dell’asse per 
identificare il punto di caricamento dell’offset impostato.
0	 Disabled
1 	 I0.0
2 	 I0.1
3 	 I0.2
4 	 I0.3
5 	 I0.4
6 	 I0.5
7 	 I0.6
8 	 I0.7

101	 Homing livello ingresso PTO1
102	 Homing livello ingresso PTO2

Determina a quale stato dell’ingresso viene rilevata la posizione di home e terminata la procedura 
di homing.
0	 Low level
1 	 High level
	

103	 Direzione homing PTO1
104	 Direzione homing PTO2

Determina in quale direzione deve spostarsi l’asse per la ricerca del segnale di home.
0	 backward
1 	 forward

105	 Velocità homing PTO1
107	 Velocità homing PTO2

Determina il valore della velocità utilizzata durante lo spostamento in fase di homing.
1..2147483647 [base 0,1 mm/s], Default: 100 = 10,0 mm/s

109	 Spostamento posizione homing PTO1
111	 Spostamento posizione homing PTO2

Determina il valore che viene caricato come posizione dell’asse al verificarsi della condizione di 
home (ingresso homing attivo)
-2147483648..2147483647 [base 0,1 mm], Default: 0 = 0,0 mm

7.2	 Digital Inputs
IW0.0	 System digital inputs word

Questa word contiene lo stato dei 16 ingressi digitali del PL280.
Bit 0: I.0.0
…
Bit 7: I.0.7
Bit 8: I.1.0
…
Bit 15: I.1.7
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7.3	 Digital Outputs
QW0.0	 System digital outputs word

Questa word contiene lo stato delle 16 uscite digitali del PL280. Per attivare le uscite impostare a 
“1” il bit corrispondente su questa word.
Bit 0: Q.0.0
…
Bit 7: Q.0.7
Bit 8: Q.1.0
…
Bit 15: Q.1.7

7.4	 Analog Inputs
AI01  	 System analog input AI1
AI02  	 System analog input AI2
AI03  	 System analog input AI3
AI04  	 System analog input AI4

Queste word contengono il valore degli ingressi analogici del PL280. Per gli ingressi configurati 
come sensori di temperatura, il valore è espresso in decimi di grado. Nel caso di ingresso 
analogico fuori range, in corto o aperto, il valore riportato sarà -32768 (corto) o 32767 (aperto).

7.5	 Analog Outputs
AO01	 System analog output AO1
AO02	 System analog output AO2

Queste word contengono il valore delle uscite analogiche del PL280. Per impostare un 
determinato valore sull’uscita analogica corrispondente, scrivere il valore su queste word in 
accordo con i limiti minimo e massimo dell’uscita fissati nella tabella parametrization

7.6	 Pulse Train Outputs
System digital outputs PTO WORD

Questa word contiene lo stato delle uscite PTO del PL280 quando configurate in modalità on/off. 
Per attivare le uscite scrivere a “1” il bit corrispondente su questa word.
Bit 0: PTO1
Bit 1: PTO2

System Axis Position PTO1
System Axis Position PTO2

Queste variabili contengono la posizione dell’asse al termine del posizionamento

System Set Axis Position PTO1
System Set Axis Position PTO2

Queste variabili contengono il setpoint di posizionamento dell’asse. 

System PWM Frequency PTO1
System PWM Frequency PTO2

Queste variabili contengono il valore della frequenza da generare dall’uscita PTO quando 
configurata come PWM.
1…200000Hz

System PWM Duty-cycle PTO1
System PWM Duty-cycle PTO2

Queste variabili contengono il valore del duty-cycle da generare dall’uscita PTO quando 
configurata come PWM.
0,00…100,00%
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System  PTO1 Command
System  PTO2 Command

Queste variabili sono utilizzate per inviare i comandi alle uscite PTO.
0:  Command ready
1:  Start absolute position
2:  Start relative position
3:  Start velocity movement
4:  Start homing position
5:  Stop position/movement
10:  Start PWM generating
11:  Stop PWM
Queste variabili vengono azzerate automaticamente una volta recepito il comando.

System PTO1 state
System PTO2 state

Queste variabili contengono lo stato delle uscite PTO. Possono essere utilizzate come feedback 
per la gestione degli assi o dei PWM.
0: Pulse/PWM off
1: Pulse/PWM running

7.7	 Encoder/counter
EV01 	 System encoder 1 value
EV02 	 System encoder 2 value
EV03 	 System encoder 3 value
EV04 	 System encoder 4 value

Queste variabili a 32 bit contengono il valore in conteggi degli encoder/contatori del PL280

EC1000_1	 System encoder 1 counts 1s
EC1000_2	 System encoder 2 counts 1s
EC1000_3	 System encoder 3 counts 1s
EC1000_4	 System encoder 4 counts 1s

Queste variabili a 32 bit contengono il numero di conteggi degli encoder/contatori del PL280 
rilevati nell’ultimo secondo. Il dato viene aggiornato ogni 1,0s.

EC100_1	 System encoder 1 counts 100ms
EC100_2	 System encoder 2 counts 100ms
EC100_3	 System encoder 3 counts 100ms
EC100_4	 System encoder 4 counts 100ms

Queste variabili a 32 bit contengono il numero di conteggi degli encoder/contatori del PL280 
rilevati negli ultimi 100ms. Il dato viene aggiornato ogni 100ms

ECMD_1	 System encoder 1 command
ECMD_2	 System encoder 2 command
ECMD_3	 System encoder 3 command
ECMD_4	 System encoder 4 command

Queste word  si utilizzano per inviare i comandi agli encoder.
Bit0 = Carica valore preset
Bit1 = Carica preset al prossimo impulso Z
I bits dei comandi vengono portati automaticamente a 0 una volta
eseguito il comando
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Responsabilità limitata
Pixsys S.r.l. garantisce le proprie apparecchiature elettroniche per un periodo di 12 mesi a decorrere 
dalla data di fatturazione. La garanzia del Costruttore è limitata alla riparazione o sostituzione delle 
parti che presentino difetti di fabbricazione e che siano rese franco nostra sede citando il numero di 
autorizzazione al reso (procedura interna autorizzazione RMA). Pixsys declina ogni responsabilità per 
incidenti e danni a persone o cose derivanti da manomissione (inclusi tentativi di riparazione da parte 
di personale non autorizzato), condizioni ambientali non idonee, installazione scorretta, uso errato, 
improprio e comunque non conforme alle caratteristiche dello strumento dichiarate nella documen- 
tazione tecnica. In nessun caso la responsabilità del costruttore eccede il valore della strumentazione. 
La garanzia non copre in alcun modo i problemi derivanti dall’installazione di applicativi software 
successiva alla vendita, ed in particolare i danni conseguenti all’esecuzione di malware. Eventuali 
interventi di assistenza da parte di Pixsys per il ripristino di sistema operativo o programmi saranno 
soggetti alla tariffa di assistenza vigente.

Note / Aggiornamenti
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Read carefully the safety guidelines and programming instructions contained in this manual 
before using/connecting the device.

Prima di utilizzare il dispositivo leggere con attenzione le informazioni di sicurezza e settaggio 
contenute in questo manuale.

PIXSYS s.r.l.
www.pixsys.net

sales@pixsys.net - support@pixsys.net 

online assistance: http://forum.pixsys.net

via Po, 16  I-30030
Mellaredo di Pianiga, VENEZIA (IT)

Tel +39 041 5190518

2300.10.377 revC
300625
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